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Introduction

Letter from the President

Dear Valued Customer,

During the past several years, we have experienced extraordinary growth and change at ATOM
Instrument, due to our continued commitment to teamwork, technology-focused product strategies and
to our policy of placing the trust of our customers above all else. We have successfully reached key
milestones, expanded research and development initiatives, achieved significant technological
advancements and initiated our position as a premier manufacturer and developer of analytical
instrumentation. In the face of challenging economic conditions, we are finding new ways to provide
solutions to an evolving industry landscape to ensure ATOM remains the brightest light on the
marketplace.

The upcoming years will be exciting as we continue to broaden our business efforts and move from
promise to product. We have set increasingly ambitious goals, but possess the passionate vision and
resources to achieve them. We have the knowledge, experience and expertise to bring specialty products
to this niche market, and we know the steps we need to take are simply an extension of what we have
been doing successfully since our inception. Simultaneously, we plan to continue responding to market
challenges and expand our line of analyzers with products incorporating enhanced features in order to
engage a wider customer base. Consequently, we have set an aggressive timeline for the development of
new products to fulfill our commitment to a "total sulfur and nitrogen analysis solution."

One of our customers has described our success story as "more a marathon than a sprint." We take pride
in this characterization and embrace it as the philosophy for our operations as a successful business is
built on sustainable and reliable growth. In recent years, we’ve grown our business substantially, yet
managed to never waver from our promise to deliver the very best products and service to our valued
customers. ATOM is building the analyzer tools of tomorrow, hearing the markets’ demands and we are
ready to meet the challenges. Watch us closely; the next five years will be a defining notch in ATOM’s
timeline.

| credit each of our devoted employees for making these past years such a success in turbulent times. |
would also like to extend my thanks to our customers and our suppliers for their unfailing sense of
devotion, responsibility, guidance and support, without which our Excimer light would have surely
extinguished long ago.

Thank you for the purchase of this ATOM Instrument product and please trust in our commitment to your
complete satisfaction. Should you have any concerns, please do not hesitate contacting us for support.

Sincerely,

Franek Olstowski, President/Founder
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Mission Statement

ATOM Instrument is founded on fundamental principles and timeless values that perpetually lie
at the heart of our business and represent the structural foundation on which it is built.
These principles have helped ATOM Instrument set a higher standard for its products and
services, making it a recognized leader for innovative solutions. Our mission is to become a
market leader in the development and manufacturing of analytical instrumentation with
unsurpassed performance that will fulfill a strategic role in industry to control processes, verify
product conformance and help solve a variety of problems for the benefit of society.

Creativity

— To establish and maintain an environment that encourages creativity and promotes innovation
in order to capitalize on collective talents and intellectual resources, to maintain a technologically
advanced position and competitive edge within the market.

Quality

— To provide superior quality products in both form and function while continually striving to
improve what may already be the best in its class.

Integrity

— Above all, to conduct all aspects of business operations while adhering to the highest level of
business ethics and standards.

Dependability

— To proactively address and reliably respond to our customer’s needs in a timely fashion.
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About This Manual

This manual is a multipart user’s manual that provides information regarding the proper
installation, operation and service of ATOM Instrument’s SLA-1000 Sulfur Process Analyzer. The manual
is divided into the following six sections.

e Section1 Principle of Operation, Specifications, and Drawings
e Section 2 Software Operation

e Section 3 Basic Maintenance Guide

e Section 4 SLA-1000 MODBUS Digital Communications

e Section5 ATOM?2 Scanner Operation and features

e Section 6 Postscript

Warranty, compliance, and safety information concerning the SLA-1000 Sulfur Process Analyzer is
provided immediately following this page.

The benefits, features and configurations of the SLA-1000 are described in Section 1 along with basic
theory and operations.

Installation and operation of the SLA-1000 and most optional equipment are illustrated in Sections 2 and
3 of this manual. Future Information may be supplied in other manuals (i.e., options manuals) or addenda
to this manual.

Maintenance information includes step-by-step procedures along with a complete set of drawings and
schematics.

The information contained herein is furnished without warranty of any kind. Users should consider the
data in this manual only as a supplement to other information gathered by them and must make

independent determinations of the suitability and completeness of the information.

Some of the terms and labels used in the manual are abbreviated intuitively due to space constraints in
tables, photos and illustrations. For further explanation, contact ATOM Instrument service.

SLA-1000 User’s Manual Page | 8



SLA-1000 User’s Manual

Conditions for Proper Use

The SLA-1000 analyzer is designed to be installed, operated and maintained as specified in this
manual. Failure to operate the analyzer as specified may produce erroneous data and possible
equipment failure which may void the warranty. Some of the conditions for proper and improper
use of the SLA-1000 analyzer are provided as follows:

The SLA-1000 analyzer is designed to continuously analyze liquid samples from a sample
handling system and display the amount of sulfur contained in the sample. Operation for
any use other than specified may damage the analyzer and/or cause personal injury to
the operator. The results obtained from any other use cannot be guaranteed.

The standard configuration of the SLA-1000 analyzer is not intended for extended use in
corrosive environments.

The SLA-1000 analyzer can be operated in open, outdoor environments but should not be
exposed to direct sunlight or precipitation.

The best accuracy and precision is obtained when the analyzer is located in a temperature
controlled environment.

To ensure safe operation, the purge system should always be engaged during operation
of the analyzer except after the area has been determined to be non-hazardous and
repairs or tests must be performed that require the purge system to be bypassed. Refer
to the manufacturer documentation included in the appendix sections of this manual
regarding the purge system operation.

The electrical power source for the analyzer must be capable of delivering 2400 Watts of
power. Note that if the sample heat tracing is powered by the analyzer, up to an additional
600 Watts may be required

The sample to the analyzer must be filtered through a 2-micron (min) filter and delivered
to the analyzer by an approved, leak-free sample handling system to ensure the sample
being analyzed is representative of the current process status.

The sample handling system should eliminate or minimize “dead volumes” and areas in
the flow path where new sample can be mixed with old sample.

Air and other gas supplied to the analyzer must be filtered and meet specified
requirements.

All cautions and warnings in this manual, on tags and in other publications pertaining
to the installation, operation and maintenance of the analyzer must be read and
observed. Failure to consider the warning and caution messages can lead to severe
personal injury, equipment damage and/or void of the warranty.

Instrument should be sheltered from direct sun or rain. If the instrument is to be used for
very low ppm concentrations, it should be located in a climate controlled area. Ambient
temperature should be between -20°C to +40°C (-4°F to +104°F).
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Warnings and Cautions

This manual provides caution and warning messages as listed below. Failure to consider these messages
can lead to severe personal injury, instrument damage and/or void of warranty.

WARNING:

POWER MUST NOT BE RESTORED UNTIL ENCLOSURE HAS BEEN PURGED
FOR 10 MINUTES WITH AN INPUT PRESSURE OF 30 PSIG.

WARNING:

A SEVERE ELECTRIC SHOCK HAZARD MAY EXIST WHEN POWER IS
APPLIED WHILE SERVICING INTERNAL COMPONENTS. Ensure that power
lines are removed from the power source before continuing.

WARNING:

A POTENTIONALLY LETHAL ELECTRICAL SHOCK HAZARD EXISTS WHEN
CONTACT IS MADE WITH THE 120VAC LINE COMPONENTS. Do not
attempt to repair or test the 120VAC section without using the
appropriate test meter with insulated probes.

WARNING:

AN EXPLOSION DANGER EXISTS WHEN THE DOOR TO A POWERED
ENCLOSURE IS OPENED WITHOUT FIRST DETERMINING THE SAFETY
CLASSIFICATION OF THE OVEN AND THE TYPE OF GASES IN THE AREA.
The area must be known to be non-hazardous before a powered
enclosure is opened. Follow the procedures for opening and closing a
powered enclosure.

WARNING:

A POOR GROUND CONNECTION MAY PRESENT A SEVERE SHOCK
HAZARD.

WARNING:

HIGH-PRESSURE GASES SHOULD BE HANDLED WITH EXTREME CARE.
Ensure that all relevant safety precautions are carefully followed and all
gas lines, regulators, gas purifiers, etc. are specified for the intended use.

WARNING:

SLA-1000 User’s Manual

A PUNCTURE INJURY MAY RESULT IF THE WAGO CONNECTOR
INSERTION TOOL IS ALLOWED TO SLIP DURING THE INSERTION
PROCESS. Some force is required to insert the WAGO tool completely into
the connector. When possible, use a vice to hold the connector during
insertion.
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WARNING:

IF THE SPECIFIED OPERATING PRESSURE CANNOT BE MAINTAINED, THE
SOURCE OF THE LEAK MUST BE CORRECTED BEFORE CONTINUING WITH
INSTALLATION AND OPERATION. Ensure the sample and main gas flow
is leak free by performing a leak test.

WARNING:

EYE INJURY CAN RESULT WHEN HANDLING THE GLASS COMBUSTION
TUBE. Wear appropriate eye protection during service, removal and
replacement of the combustion tube.

WARNING:

PERMANENT EYE DAMAGE CAN OCCUR DUE TO LOOKING DIRECTLY
INTO AN ILLUMINATED UV LIGHT SOURCE. Wear appropriate eye
protection when looking directly into a UV light source.

WARNING:

SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT
COMBUSTION TUBE. Allow the combustion tube to cool before
performing maintenance.

WARNING:

SEVERE BURNS CAN RESULT WHEN WORKING AROUND A HOT
FURNACE. Allow the furnace to cool before performing maintenance.

WARNING:

AN ELECTRICAL SHOCK HAZARD MAY EXIST AND SEVERE COMPONENT
DAMAGE MAY OCCUR WHEN USING A LIQUID LEAK DETECTOR. Even
though the solution in an approved liquid leak detector “Snoop” solution
is non-conductive, care should be taken not to wet any electrical or
electronic components.

CAUTION:

Most liquid leak detectors contain sulfur compounds that can
contaminate the gas supply line and instrument flow path components.
Care should be taken not to wet or contaminate the analytical flow
system when using a liquid leak detector.

CAUTION:

Become familiar with the location and use of all controls, indicators,
connections and accessories and carefully read all instructions and
warning labels prior to operating any portion of the system.

CAUTION:

The SLA-1000 should be sheltered from direct sunlight and precipitation
exposure.

CAUTION:

Carefully ensure the system is leak free. Failure to do so may cause
severe system component damage.

CAUTION:

SLA-1000 User’s Manual

Instrument Air for the sample injection must be set to a pressure of 70
psi. Lower activating pressure may result in improper actuation while
higher pressure may cause damage to these valves.
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CAUTION:

Line Voltage to analyzer must be supplied from an External Power
Breaker with the specified current and voltage properties.

CAUTION:

All seals MUST be poured before energizing the unit.

CAUTION:

Follow Installation Drawings and Schematics in this manual to bring the
unit on line.

CAUTION:

Do not attempt to operate the SLA-1000 until all installation and setup
procedures outlined in the previous listed sections of this manual have
been successfully completed.

CAUTION:

Serious instrument damage can result if the SLA-1000 is not fully
functional and/or if the operator is inexperienced with the computer
control.

CAUTION:

The glass combustion tube is easily broken during removal of the
transfer tube fittings. Care must be taken not to apply pressure to the
glass tube when removing the transfer line.

CAUTION:

The glass combustion tube inlet and outlet connection points are easily
broken during removal. Care must be taken not to allow force to be
applied to the tube when removing these connections from the glass
combustion tube.

CAUTION:

Do not over tighten fittings. Over-tightening can cause restrictions,
which will affect instrument performance. If ferrules need replacement,
the fittings should be tightened according to the standard industry
practice.

CAUTION:

The Excimer UV lamp is extremely fragile. Extreme care should be taken
with these lamps to avoid breakage.

CAUTION:

Ensure that all interconnections are properly installed. Improper
connections may cause damage to system components when power is
applied.

CAUTION:

The Photo Multiplier Tube (PMT) is extremely light sensitive. Any
exposure to ambient light with PMT power applied will result in
extreme damage to the PMT. As a result, power to the PMT should
always be turned off before exposing the PMT window to any ambient
light.

CAUTION:

SLA-1000 User’s Manual

Ensure all inlet and outlet openings are kept clean and free from
contaminants. It is recommended that the inlet and outlet openings be
covered with tape when not connected to lines.
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CAUTION: Do not exceed recommended pressures. If higher pressures are used,
severe and irreparable damage may be done to fragile system
components.
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Warranty

@” M Instrument

firPLIED TECHNOLOGY of @PTiIcAL METHODS

ATOM Instrument SLA-1000 Standard Warranty

Atom Instrument warrants that all products supplied will be of merchantable quality and will comply with
the specification agreed for them.

Atom Instrument guarantees for a period of twelve months from installation of the product or fifteen
months from delivery to the customer, whichever is the shorter, all Products and spare parts sold
hereunder.

ATOM Instrument will repair or replace defective and/or nonconforming parts without charge for material
or labor service during the warranty period.

Products that have been repaired or replaced during the warranty period are themselves warranted only
for the remaining portion of the original one (1) year.

Repairs, adjustments and service performed after the expiration of the one (1) year warranty period shall
be charged to the owner/purchaser at the then current prices for parts, labor, and travel related expenses.

Exceptions to this warranty are:

- Defects, damage, or nonconformity resulting from abuse, misuse, neglect, lack of reasonable care,
unauthorized modification, or the attachment of improper devices to the products.

- Installation, operation and maintenance of the products in a manner that does not meet ATOM
Instrument specifications will void this warranty.

- All requests for service or repair under this warranty must be received within the warranty period
by ATOM Instrument or its authorized representative.

The warranties contained in this agreement are in lieu of all other warranties, expressed or implied,
including the warranties of merchantability and fitness for a particular purpose.

Statements made by any persons, including representatives of ATOM Instrument, which are inconsistent
or in conflict with the terms of this warranty shall not be binding upon ATOM Instrument unless reduced
to writing and approved by an officer of the company.

Liability covered under this warranty is limited to the original cost of the ATOM Instrument supplied
equipment. ATOM Instrument will not be liable for consequential damages including but not limited to
loss of production, throughput or off specification product due to user or equipment error.

This warranty shall be governed by and construed in accordance with the laws of the State of Texas.
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Service

Service Contact Information

Address: Phone Number:
1656 Townhurst Dr, Suite B 713-461-0034
Houston, TX 77043

Service Rate Information
Effective: January 1, 2019

ATOM Instrument offers quality service and preventative maintenance work at reasonable rates.
Our goal is to provide consistent and reliable service with an emphasis on customer satisfaction.

Hourly Field Service Rate:
Standard Rate (Regular Business Hours 8am-6pm)
Premium Rate (Outside of Regular Business Hours)

Field Acceptance Test (FAT):

At ATOM Instrument Locations (1%t Analyzer)

At ATOM Instrument Locations (From 2" Analyzer)
At Customer Site

Additional Day at Customer Site

Minimum Charge:
2-Hour (Customer Location less than 100 mi. from Houston)
4-Hour (Customer Location greater than 100 mi. from Houston)

Travel Rate:

Travel Time

Travel Day (8 Hour/ day maximum)

Foreign Countries (Flights Longer than 6 hours from Houston)
Personal Auto Mileage (Rounded IRS Mileage Rate for 2019)

Reasonable Travel Expenses:
(Airfare, lodging, surface transportation, meals, etc.)

Misc. Charges:

(Includes license fees, customs fees, excess baggage fees, training fees, etc.)

Cancellation Charges:
Prior to departure for travel expenses incurred

(i.e. fees for cancellation of airline, hotel, or rental car reservations, plus time spent)

SLA-1000 User’s Manual

$237.50 / Hour
S 300.00 / Hour

$2,400 / Unit
$1,900 / Unit
$1,900 / Day
$1,900 / Day

$475.00
$950.00

$125.00 / Hour
$1000.00 / Day
$2000.00 / Day

Actual Cost

Actual Cost

Actual cost
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In-house repair:
Includes repairs done at ATOM and parts or assembly preparation time for $150.00/Hour
service visit.

Annual Preventive Maintenance Plan:

1 day field service work to perform PM (must be scheduled within valid plan year Based on
on mutually agreed upon date) Analyzer and
Parts replaced during PM- sample valve, combustion tube, transfer tube with site location

ferrule (for SLA only), thermocouple (any additional parts required to be invoiced
separately)

Software updates

Year around phone support (provides for return call within 4-6 hrs. anytime during
valid plan year) 48 hrs. onsite response time for service calls (within valid plan year
only; time and expenses invoiced additionally to plan price).

Payment Methods:
e Purchase Orders from customers with approved credit, Net 30 days.
e Credit Cards Accepted (MasterCard, VISA, American Express and Discover)

Limited Warranty

Any replaced parts and service labor performed in replacing associated parts is warranted for a period of
90 days from the date of service. This warranty excludes travel time and expenses if returning to
customer site to make repairs is requested. ATOM attempts to maintain stock of essential parts that
may be necessary for general repairs and preventative maintenance.
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Recommended Consumable Spare Parts List

Part Number

60064-00001
60038-00001
60097-10005
23058-00002

23300-00250
10676-00001
11228-00001
60008-10001
10027-00001

Description

SLA Online Combustion Tube, 10.75 L
Combustion Furnace

Assy, Thermocouple, Single S Type
Valve, 4-Port Internal Sample Injector, Valcon E, 2ul, High-Temp
Air Actuator

Transfer Tube .010" ID x 9" Long

Ferrule, External Reducing, 1/16" to 1/32", Polyamide, Valcon
Dryer, .110" ID, 72" L, Fluorocarbon Fittings

Excimer Lamp Envelope

Ferrule, Standard 1/4", Graphite, (2/Pk)

Quantity

s

OR R RRE

Recommended Replacement Spare Parts List

23058-00002

11258-00001
10027-00002
23300-00250
10676-00001
60037-10001

60038-00001
60097-10005

60064-00001
10027-00001
23251-00001
23252-00001

23248-00001
60203-10001
23135-00001
60037-00002
11572-00001

e

e

e

SAMPLE ENCLOSURE SECTION

VALVE, 4-PORT INTERNAL SAMPLE INJECTOR, VALCONE, 1pL, HIGH-

TEMP AIR ACTUATOR
THERMOCOUPLE, TYPE K, 6" LONG

FERRULE, STANDARD 1/8", VESPEL
TRANSFER TUBE .010" ID X 9" LONG

FERRULE, EXTERNAL REDUCING, 1/16" TO 1/32", POLYAMIDE, VALCON

ASSY, HEATER, SAMPLE ENCL

COMBUSTION FURNACE SECTION
COMBUSTION FURNACE
ASSY, THERMOCOUPLE, SINGLE S

COMBUSTION KIT - INCLUDES:
COMBUSTION TUBE

FERRULE, 1/4", GRAPHITE (2/PK)

TUBING, PTFE TEFLON. 1/8" O.D .X 1/16" I.D. (10FT./PK)
FERRULE, SET, 1/8” (10/PK)

MAIN ENCLOSURE SECTION
COMPUTER, TOUCH SCREEN, 12IN
ASSY, COMPUTER SCREEN PROTECTOR
Z-PURGE

ASSY, HEATER, ELECTRONICS ENCL
VALVE, SOLENOID, 3-WAY

SLA-1000 User’s Manual
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11572-00002
11478-00001
23242-00001
23245-00001
11506-00001
11280-00001
11233-00001
11224-00001
11262-00001

11525-00001
11526-00001
23123-00001
60078-10001
60059-10001
60079-00004
60003-10001
60008-10001
60001-10001
11228-00001
23109-00001

N N

P PR R R RRERRRE R PR

VALVE, SOLENOID, 4-WAY

CONNECTOR, DIN, MANIFOLD, 24VDC

PRESSURE SWITCH ASSY, ADJUSTABLE, 4-125 PSI, 7A, 250V
MASS FLOW CONTROLLER, AIR 500 SCCM

TEMPERATURE CONTROLLER, SSR OUT, 24V

SOLID-STATE RELAY (SSR), 25A, 240 VAC

UNIVERSAL SIGNAL CONDITIONER, 24V, 4-20 MA OUT
THERMOCOUPLE, 30 AWG TYPE K, PFA

THERMOSTAT, 1/2" DIS, AUTO RESET, 15A OPEN@ 48.9C, CLOSE@
32.2C
SOLID-STATE RELAY (SSR), 5VDC, DIN MOUNT

RELAY, 24V, DIN MOUNT

POWER SUPPLY, 24V, 4.2A, 100W, DIN RAIL
SP-2000 SIGNAL PROCESSOR BOARD PCA
EXTERNAL INTERFACE BOARD PCA

DC/DC CONVERTER, QUAD 24/5V,+15V,-15V,12V
DETECTOR WITH PMT

EXCIMER LAMP ENVELOPE

EXCIMER LAMP ASSY

DRYER, .110"1D, 72" L, FLUOROCARBON FITTINGS
REGULATOR, AIR, 0-60 PSIG

SLA-1000 User’s Manual
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SLA-1000 Preventive Maintenance Schedule

Recommended schedule for parts replacement *

SLA-1000 User’s Manual

10027-00001
23058-00002

2 years **
PART NUMBER DESCRIPTION
60097-10005 ASSY, THERMOCOUPLE, SINGLE TYPE S
60064-00001 COMBUSTION TUBE

FERRULE, 1/4", GRAPHITE (2/PK)
SAMPLE VALVE, 4-PORT, 1ul

4 years **

PART NUMBER

60038-00001
60097-10005
60064-00001
10027-00001
23058-00002

DESCRIPTION
FURNACE, ON-LINE ANALYZER
ASSY, THERMOCOUPLE, SINGLE TYPE S
COMBUSTION TUBE

FERRULE, 1/4", GRAPHITE (2/PK)
SAMPLE VALVE, 4-PORT, 1pl

6 years **

PART NUMBER

60008-10001
60097-10005
60064-00001

10027-00001
23058-00002

DESCRIPTION
ENVELOPE, EXCIMER, UV LAMP
ASSY, THERMOCOUPLE, SINGLE TYPE S
COMBUSTION TUBE
FERRULE, 1/4", GRAPHITE (2/PK)
SAMPLE VALVE, 4-PORT, 1ul

* these are the minimum recommended replacement intervals and are based on
customer provided data; customers are urged to use their discretion to choose schedule for
parts replacement

** this only lists typical recommended parts, any other parts if needed, will be additional-
please take this into account when planning for budgetary purposes

SLA-1000 User’s Manual
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Section 1 - Principle of Operation, Specifications, and
Drawings

Section 1.1 Principle of Operation

The ATOM SLA-1000 is an online process analyzer utilizing patented Excimer UV Fluorescence
(EUVF) technology to measure Total Sulfur in a variety of applications such as monitoring of total
sulfur in liquid process streams.

The UV Fluorescence method (UVF) is one of the most simple and practical low-level sulfur
analytical techniques that has been widely used and proven over many years of industrial
utilization. The UV Fluorescence method involves injection of a sample into a high-temperature
oxidation or combustion furnace, which converts all hydrocarbons into water (H,0O) and carbon
dioxide (CO,) byproducts. Total Sulfur content contained in any molecular-bound hydrocarbon
species is similarly oxidized at temperatures in excess of 1000°C into sulfur dioxide (SO2) by the
reaction:

R-SH + O; - SO, + CO;, + H,0

The furnace effluent containing these combustion byproducts is directed into a detection
chamber where it is excited by high-energy, short-wavelength emission from a UV excitation
source. The UV photons from the excitation source or lamp, transfers energy into the SO,
molecule and raises its energy level to create an excited singlet state. These excited molecules
rapidly decay back to their lower energy ground state releasing the absorbed energy as a
secondary emission known as fluorescence.

SO, + hv > 502* - S0, + hv’
This low-level fluorescence emission is optically filtered to remove undesired wavelengths of the
UV source and background scatter within the detector chamber. Detection of the filtered

fluorescence emission is usually accomplished with a Photomultiplier Tube (PMT), Channel-Plate
Multiplier (CPM) or other high gain, light-sensitive detector.
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Section 1.2 Specifications

Analytical Performance
Measurement Method
Measurement Range
Repeatability

Linearity
Response Time
Calibration

Analog/Discrete Data
Communications

Analog Outputs

Alarm Outputs

Digital Data
Communications

Local MMI

Remote Interface

Utility Requirements
Ambient Temperature
Power

Instrument Air
Zero Grade Air

Physical Parameters

Dimensions

Mounting

SLA-1000 User’s Manual

Total Sulfur by Excimer UV Fluorescence (EUVF)

0.5 ppm — 10,000 ppm (Application dependent)

200 ppb SD or +2% of measured value, whichever is greater
100 ppb SD with 5-min. averaging or +2% of
measured value, whichever is greater

+2% of full scale

99% in one cycle (60-100 s typical)

Automatic or manual

Two 4-20 mA DC (optional)

One global dry contact triggered by one or more of the
following:

Power Failure, Loss of Purge, Low Oxidizer Pressure, User-
configured Digital Inputs (D14 — DI7)

RS-232, RS-485/422 MODBUS (TCP/IP optional)

12" Touchscreen Computer with Embedded Windows 7
allows complete operation and control of all analyzer
functions

Complete control of ATOM SLA, including monitoring of
analysis parameters and digital data values

-20°C to +40°C (-4°F to +104°F)

120 VAC, 25 A, 50/60 Hz at 3000 watts

70 psig (4.8 bar), 7 SCFM, Qil Free, -40°C (-40°F) dew point
40 psig (4.8 bar), 200 SCCM

965.2 mm (38.0 in) high x 660.4mm (26.0 in) wide x 304.8 mm
(12.0in) deep

Wall or Unistrut Stand

©2016 ATOM Instrument, LLC. All rights reserved. Specifications, terms and pricing are subject to

change.

SLA-1000 User’s Manual
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Section 1.3 SLA-1000 Drawings
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Section 1.3.3 Total System Wiring
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Section 2 — Software Operation

This section of the manual is intended to provide a complete overview of the SLA-1000 software
providing the user a fundamental understanding of analyzer operation.

There are 3 programs incorporated into SLA-1000 software that have distinct functions, but work
together to provide complete control and user interface of the SLA-1000 instrument. The main
SLA-1000 software program operates in the background and controls all aspects of analyzer
operation, which includes protocols for communicating with the detector module. The detector
module firmware is a distinctly separate, machine-language program embedded in the onboard
microprocessor. The third program is a colorful, high-contrast Graphical User interface or GUI
that provides a user-friendly interface comprised of an organized set of intuitive menu screens
that are configured for ease of use.

Start Up

Upon powering up the SLA-1000, the touchscreen will begin to turn on and Windows 7 will boot.
If an administrator password has been set up for Windows 7, the password can be entered using
an external keyboard plugged into a USB port to access the software. If no keyboard is connected,
the touchscreen keyboard can be displayed by pressing the “Ease of access center” button at the
bottom left of the screen and then selecting the “Type without the keyboard (On-Screen
Keyboard)” option.

If no Windows administrator password has been implemented, the main GUI menu (Figure 2.1)
will open automatically after the SLA-1000 and touchscreen computer are powered on. All sub-
menus may then be accessed from this bar found at the top of the desktop screen.

File Settings View Windows Help

Figure 2.1 — Main Menu

In order to access any of the sub-menus of the GUI, the user must first log into the system. Refer
to section 2.1.1 for Login information
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Section 2.1 File Menu

File' Settings View Windows Help

Logout
User Setup
Exit

Figure 2.2 — File Drop down Menu

Section 2.1.1 Login

The Login feature allows users to interface with the software on two separate levels. Users
without administrative privileges are limited to menu access for viewing purposes only. Those
users with administrative privileges have complete access to all menu settings, which can be
modified as necessary for customizing or optimizing instrument operation (selectable in User
Setup, Figure 2.6). The Login feature is intended to prevent unauthorized changes to instrument
operation, allowing it to retain current settings unless an authorized user logs in with valid
credentials (Figure 2.3).

To log in to the analyzer, click File > Login. Select the ID line.

Figure 2.3 — Login Screen

A touchscreen keyboard should automatically pop-up on the screen (Figure 2.4).

&3 On-Screen Keyboard

Home angUp
|End Pg[Sn
Insert |[Pause
PrtScn |/ScrLk

||'Options |[Help

Figure 2.4 — Touchscreen Keyboard

SLA-1000 User’s Manual Page | 32



SLA-1000 User’s Manual

Using the touchscreen keyboard, enter the username ID. Then Select the Password line and enter
the user assigned password. After proper user credentials have been entered, press the OK
button to complete the Login process.

NOTE: At any attempt to access a screen that requires administrative privileges, the Login
screen will automatically pop-up and prompt the user for the required credentials.

NOTE: The dropdown menu will read Logout if a valid login has already been entered
(Figure 2.5).

File' Settings View Windows Help

Logout
User Setup
Exit

Figure 2.5 — User Already Logged In

There is an auto-logoff feature in place to automatically logout any user after 15 minutes of
inactivity. After this time, any screen that requires administrative privileges to change or modify
settings will automatically cause the Login Screen to reappear and prompt the user to re-enter
the required credentials.

Section 2.1.2 User Setup

The User Setup screen is accessed from File > User Setup. Three levels of user privileges are
assigned and defined as Admin, Tech and View (Figure 2.6).

User Settings
{8 ! wrd | Admin | Tech
admin

Lserl

user?

Figure 2.6 — User Settings Screen
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Below is a description of each user’s privilege:

Admin | Tech | View
View any GUI screen X X X
Modify analyzer parameters X X
Modify user privileges X

When logged in as a system administrator, pressing the B will delete the corresponding user
profile. The factory “admin” cannot be deleted nor can the name be modified. However,
subsequent users with “Admin” privileges can be created or deleted. The administrator can add
users and assign/change a user’s privileges. To add a user, click on the last empty ID field and
enter the user name, a password and then select user level (Admin/Tech/View) to finish user
registration.

Section 2.1.3 Exit

By clicking File > Exit, the GUI program will close; however the SLA-1000 main program will
continue to run if there are no operational restrictions, such as loss of purge or other system
critical alarm function.

Section 2.2 Settings

File "Settings View Windows Help

Home

Calibrate Settings
Detector Settings
Digital 1/0 Label
Digital 1/O Status
Output Settings
Purge Override

System Settings

Timed Event Settings

Figure 2.7 — Settings Dropdown Menu
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Section 2.2.1 Home

The Home Screen is the top screen in the Settings menu and is considered to be the primary user
interface for an overview of routine analyzer operation. (Figure 2.8). The Home menu functions
are arranged in groups and are discussed separately.

Home
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Figure 2.8 —